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1 Technical Specifications UM-TEO0630 (v 0.21) 3 July 2013

1 Technical Specifications

1.1 Module options
FPGA options

Module can be ordered with Spartan-6 XC6SLX45, XC6SLX75, XC6SLX100,
XC6SLX150 chip’.

Temperature grade options

Module can be ordered in commercial or in extended (from -25 C° to +85 C°)
temperature grade.

1.2 Dimensions

Figure 1 shows main module dimensions from top view.
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Figure 1: Module dimensions in mm

Mounting hole diameter is 3.2 mm.

1 Contact Trenz Electronic support for availability
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2 Detailed Description UM-TEO0630 (v 0.21) 3 July 2013

® External supply - When R103 is not populated and R102 is not
populated. In this case external supply source have to be connected to pins
1, 2, 3, 4 of J4 B2B connector?.

Others options of VCCIO0 power supply are not supported and can
damage the FPGA!

See Figure 4 to locate R102 and R103 on PCB.

Figure 4: R102 and R103 location

Supply

Voltage
BO VCCIOO0
B1 1.5V
B2 3.3V
B3 3.3V

Table 1: FPGA banks VCCIO power supply

Note that some of Spartan-6 I/O types are partially compatible, so pins of
compatible types can be used as inputs for signal of other type. See “Spartan-6
FPGA SelectlO Resources” page 38 for detailed information.

2.2.4 Power-on Reset

During power-on, the /RESET line is first asserted. Thereafter, the supply
voltage supervisor monitors the power supply rail 3.3V and keeps the /RESET
line active (low) as long as the supply rail remains below the threshold
voltage(2.93 volt). An internal timer delays the return of the /RESET line to the
inactive state (high) to ensure proper system reset prior to a regular system
start-up. The typical delay time ty of 200 ms starts after the supply rail has risen

2 See Spartan-6 documentation fo VCCIO power range.
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2 Detailed Description UM-TEO0630 (v 0.21) 3 July 2013

above the threshold voltage.

3.3V

IRESET]

Figure 5: Reset on power-on

After this delay, the /RESET line is reset (high) and the FPGA configuration can
start. When the supply rail voltage drops below the threshold voltage, the
/IRESET line becomes active (low) again and stays active (low) as long as the
rail voltage remains below the threshold voltage (2.93 volt). Once the rail
voltage raises again and remains over the threshold voltage for more than the
typical delay time t4 of 200 ms, the /RESET line returns to the inactive state
(high) to allow a new system start-up.

2.3 FPGA User I/Os

TE0630 provides user I/O signals connected to B2B connectors J4 and J5.
There are 3 types of user I/O signals:

® Single ended;
@ Differential pairs (each pair is configurable as 2 single-ended digital 1/0s);

@ Differential pairs, which can be used as clock inputs (each pair can be used
as usual differential pair or 2 single-ended digital 1/0s).

Table 2 show user I/O count for J4 and J5.

J4 J5 Total
Single ended 12 18 30
Differential 18 16 34
Differential (clock) 4 2 6
Total 56 54 110

Table 2: User I/0 count by connector

Table 3 show user I/O divided by VCCIO supply voltage.

VCCIOoo0 3.3V Total
Single ended 1 29 30
Differential 18 16 34
Differential (clock) 4 2 6
Total 45 65 110

Table 3: User I1/0 count by VCCIO
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2 Detailed Description UM-TEO0630 (v 0.21) 3 July 2013

2.4 Board-to-board Connectors

The module has two B2B (board-to-board) receptacle connectors (J4 and J5)
for a total of 160 contacts. Figure 6 shows B2B connectors location on board;

USB connector is located on the top side and is shown to define module
position.

Figure 6: B2B connectors location

TEO0630 uses high-density shockproof connectors shown in Figure 7. Connector
part numbers are listed in Table 4.

Figure 7: Module connector

Supplier Header
H11113CT-ND
Digikey H11113TR-ND
H11113DKR-ND
Hirose DF17(3.0)-80DS-0.5V(57)
Trenz Electronic 22684

Table 4: Module connectors part numbers

The on-board receptacles mate with their corresponding headers on the carrier

board shown in Figure 8. Ordering numbers of mating connectors are listed in
Table 5.
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2 Detailed Description UM-TEO0630 (v 0.21) 3 July 2013

Signal name FPGA pin LED
U_LED1 F1 D3
U_LED2 F2 D5
U_LED3 J4 D6
U_LED4 K8 D7

Table 9: LEDs pin-out

2.13 Push-Button

TE0630 module is equipped with one active-high push-button (signal is set to
logical "1" when button is pressed). Table 10 show push-button connection

details.
Signal name FPGA pin PB
PB R7 S5

Table 10: Push button pin-out

2.14 DIP Switch

On-board 4xDIP switch S1 used for system and user settings.

Switch 1 (S1A) is used to connect the USB controller to the 1°C serial EEPROM.
When S1Ais "ON", serial I>°C EEPROM is connected to the USB controller,
when switch is "OFF", the USB controller is disconnected from the EEPROM*.
Turn S1A off when programming the USB EEPROM (storing the USB vendor ID
and device ID). This will force the USB controller to provide its default vendor ID
and device ID.

Switch 2 (S1B) is used to control DC-DC converters. When switch is "OFF",
converters are controlled by the USB controller. When switch is "ON",
converters are enabled regardless of USB controller actions. At start-up, the
USB controller switches off 1.2V, 1.5V and 2.5V power rails and starts up the
module in low-power mode. After enumeration, the USB controller firmware
switches the 1.2V, 1.5V and 2.5V power rails on, if enough current is available
from the USB bus.

Switches 3 (S1C) and 4 (S1D) can be used as user switches. Switches are
active-low. Pull-up resistors should be defined in user constrains file (UCF) to
use this switches in FPGA design. See Table 11 for details.

Signal name FPGA pin Switch
I0_L61_N_1 AB21 S1C
I0_L63_N_1 AA22 S1D

Table 11: DIP switch pin-out

2.15 Board revisions and assembly variants

To determine PCB revision and assembly variant from FPGA, TE0O630 have
dedicated user signals, which can be read by user core.

Board revision coded in 4 bits BR[3:0]

4 Zero-resistor R90 (not populated by default) short this switch and connect EEPROM regardless of S1A position.
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UM-TE0630 (v 0.21) 3 July 2013

ended lines. Differences in pin types shown in Table 16, not listed signals have
same or compatible® type.

Connector:Pin TE0300 pin name TEO0300 Type TEO0630 pin name TE0630 Type

J4:5 B3_LO1_P DIO V3_l0_01 slo
Ja:7 B3_L01_N DIO V3_10_02 slo
J4:9 B3_L02_P DIO V3_l0_03 slo
Ja:11 B3 _L02_N DIO V3_l0_04 sIo
J4:17 BO_L24 N DIO V0_IO_01 slo
Ja:19 BO_L24 P DIO V0_I0_01 N DIO
J4:6 B3 _LO7_P DIO V3_l0_06 slo
J4:8 B3_LO7_N DIO V3_l0_07 slo
J4:10 B3_L03_N DIO V3_I0_08 slo
Ja:12 B3_L0O3_P DIO V3_l0_09 slo
J5:13 B3 L22 P DIO V3_10_12 sIo
J5:15 B3 L22 N DIO V3_10_13 slo
J5:19 B3 _L20_P DIO V3_10_14 sIo
J5:21 B3 _L20 N DIO V3_10_15 slo
J5:16 B3_L21 N DIO V3_10_17 sIo
J5:18 B3 L21 P DIO V3 10_18 slo
J5:20 B3_L23 N DIO V3_10_19 slo
J5:22 B3 L23 P DIO V3_I0_20 sIo
J5:32 B2_L06_P DIO V3_l0_24 slo
J5:34 B2_L06_N DIO V3_l0 25 sIo
J5:41 B2_GCLK13 clo V2_10_02 slo
J5:49 B2_GCLK_L13_N clo V210 24 P DIO
J5:51 B2_GCLK_L13_P clo V2 10 24 N DIO

Table 16: TE0300 and TE0630 pin types differences.
See Table 17 for pin types definitions.

Type
colour code

DIO

Description

Unrestricted, general-purpose differential user-1/0O pin.

SIO

Unrestricted, general-purpose user-1/O pin.

CIO

Unrestricted, general-purpose differential user-1/O pin. This pin also can be used as FPGA clock input.

Table 17: TE0300 and TE0630 pin types

Most user signals to B2B connectors routed from same FPGA banks.
Differences shown in Table 18.

5 Signals routed as differential pairs can be used as single ended.
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3 TEO300 compatibility UM-TE0630 (v 0.21) 3 July 2013

Connector:Pin TEO0300 Bank TE0630 Bank
J4:15
J4:36
J4:52
J5:33
J5:28
J5:30
J5:32
J5:34
J5:38
J5:40
J5:42
J5:50
J5:52

Table 18: TE0300 and TE0630 user signals /O banks differences.
I/O Banks power supply for both modules shown in Table 19.

o
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Bank TE0300 TE0630
BO VCCIO (1.2V-33V) | VCCIO (12V-33V)
B1 25V 15V
B2 3.3V 3.3V
B3 3.3V 3.3V

Table 19: TE0300 and TE0630 FPGA I/O banks power supply.

Bank 0 1/0 supply voltage at both modules can be configured by user, see
chapter 2.2.3 On-board Power Rails.

4 Module Configuration
Full module configuration cycle (for just assembled board) include steps:
Generic USB driver installation
USB microcontroller large EEPROM programming
EEPROM programming

W=

Dedicated driver installation
5. SPI Flash configuration

Steps 1-3 already performed at Trenz Electronic laboratory, and not required
to perform by end user.

To work with TE0630 module using USB interface user should install dedicated
USB driver, which provide API to work with main module functions, for complete
instructions see chapter 5.2 Dedicated driver installation.

The FPGA on the TE0630 can be configured by SPI Flash or by JTAG
connector.

4.1 JTAG FPGA Configuration

Programming using JTAG interface provide convenient and fast way to test
FPGA project. FPGA configuration programmed this way is volatile and lost
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after reset or power cycle.

4.2 SPI FPGA Configuration

The bit-stream for the FPGA is stored in the SPI Flash. To use this bit-stream
source FPGA configuration option is set to “Master Serial/SPI”. See 2.8 SPI
Flash for additional information.

SPI Flash can be programmed in several ways:

® Direct programming by USB controller (usually done by Firmware Upgrade
Tool).

® Indirect SPI programming via FPGA pins, controlled by JTAG (can be done
using Xilinx IMPACT). See Appendix A. Indirect SPI Programming using
iMPACT.

® Direct SPI programming by FPGA, using an SPI core (FPGA project should
contain SPI interface core and software to work with it).

In SPI Flash mode, the FPGA’s internal oscillator generates the configuration
clock frequency. The FPGA provides this clock on its CCLK output pin, driving
the PROM'’s Slave Clock input pin. The FPGA begins configuring using its
lowest frequency setting. If so specified in the configuration bitstream, the FPGA
increases the CCLK frequency to the specified setting for the remainder of the
configuration process. The maximum frequency is specified using the
ConfigRate bitstream generator option. The maximum frequency supported by
the FPGA configuration logic depends on the timing for the SPI Flash device.
For TE0630 SPI Flash PROM, use ConfigRate = 12 or lower.

This options are set graphically in Xilinx ISE Software Project Navigator by
selecting the following:

® Generate Programming File > Process Properties > Configuration Options >
Configuration Rate > 12 (or lower)

4.3 eFUSE programming

To program eFUSE at TE0630 module follow the steps below.

® Connect 2.5V power rail to 3.3V power rail. It can be done on B2B connector
see 6 B2B Connectors Pin Descriptions. Or if module connected to
baseboard, better to short power rails on baseboard.

® Program eFUSE using JTAG cable and iMPACT software.

® Disconnect 2.5V and 3.3V power rails.

4.4 EZ-USB FX2 Firmware Programming

TE0630 module supplied with already programmed FX2 firmware, so this
procedure is not needed for normal work flow. This procedure is required
only if custom firmware used or to restore firmware.

If the EEPROM has never been programmed before (virgin module) Switch 1
(S1A) can be switched to EEPROM (to "ON" state). See chapter 2.14 DIP
Switch for details. The USB microcontroller will detect an empty EEPROM and
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4 Module Configuration UM-TEO0630 (v 0.21) 3 July 2013

will provide its default vendor ID and device ID to the USB host. If the EEPROM
has been programmed before (EEPROM not empty), S1A must be switched to
"OFF". The USB microcontroller will detect a missing EEPROM and will provide
its default vendor ID and device ID to the USB host.

4.5 EZ-USB FX2 EEPROM Programming

TE0630 module supplied with already programmed EEPROM, so this
procedure is not needed for normal work flow. This procedure is required
only if custom firmware used or to restore firmware.

First of all, check that Switch 1 (S1A) is actually switched to EEPROM. The
USB EEPROM can be programmed by opening the dedicated software
“Cypress USB Console” (double click the “CyConsole.exe” file in the
“1st_program\CyConsole” folder).

T Cypress USB Console

File ©Options Help
% [=] @ [x] Selected Script: X % (5 24/?

Select Device

USE Addrezz | Device Mame Mame in windows Device Mar [from .inf]

ienerc USE Device

Device Fropertties | Control Endpt Xfers] DtherEndthfers] Mizc. ]

VendorlD ... .. 0x04B4 Class .. ... O=FF
PraductD .. ... 0x8613 Subclass . . 04FF
M anufacturer . . . Protocal . . OxFF
Product. ... ... becdDevice OxA001

Serial Number . .

Device Configurations [ 1]
Yalue | Attributes | I i Piowwer |
0x01 080 0232 (100 ma)

Configuration Interfaces [4)

|t | Al Setting | Clazs | Subclazs Pratocol ~
u] u] 0xFF [ Wendor ] OxFF OxFF
] 1 0=FF [ Wendaor ) 0=FF 0=FF
] 2 0=FF [ Wendar ) 0=FF 0=FF hd

Interface Endpointz [ 0]
Address | Aftributes Max Pkt Size Irteryval

Click “Options > EZ-USB Interface” to Open EZ-USB Interface window.
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T EZ-USB Interface

Device |USB Device | [y o | Lozdnin | s EcpRom | seeotin |

et Dew | Get Cont | Get Pipes | Bet Strir\gs| Dourload ‘ |§.gEEPRDM URB Stat ‘ HOLD | RUN |
w Reo [0x00 Yalue [0x0000 Incex [0x0000 Length [0 ©Di [0 OUT | HexBytes [CO B4 04 81 00 01 00 +|
ot | Pipe | Lengh [128°  PacketSize [ Packets [
Q Pipe | v Lergin [64 Hex Bytes [5 |

Reset Pipe | Aot Pipe ‘ File Trans .. | Fipe -
Set [Face | Interface ’0_ AltSetting ’l]_

“S EEPROM?” button refers to the small EEPROM (256 bytes) whereas the “Lg
EEPROM’ refers to the large EEPROM (64 KB). Press the “Lg_ EEPROM”
button, select the “USB.iic” file and press the “Open” button to start writing to

EEPROM.
Large (512 - 64K byte) EEPROM Download 7)x)
Suchenin: | [ TED300 - = E3-

() driver
CHCvCansale

Zuletzt
wverwendete D

'_v"_'.'
L
Deskiop

=,

Eigene Dateien

Arbeitzplatz
Dateiname: |usb.iic: j Qffren |
Netzwerkurmgeb D ateitup: |i2c: EEPROM Files [*.iic) j Abbrechen
ung

™ Schieibgeschiitzt Sfnen

Upgrade progress is displayed in status window and is completed when
“Download Successful” text is displayed.
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Hardwareinstallation

] ‘_\ Die Software, die fur diese Hardware installiert wird:
L]

Cypress Genenc USE Device

hat den *Windows-Logo-Test nicht bestanden, der die F.ompatibilitat mit
Windows XP Uberpriift. [warum izt disser Test wichti?]

Das Fortzetzen der Installation dieser Software kann die korrekte
Funktion des Systems direkt oder in Zukunft beeintrachtigen.
Microzoft empfiehlt strengstens, die Installation jetzt abzubrechen
und sich mit dem Hardwarehersteller fur Software, die den
Windows-Logo-Test bestanden hat, in Yerbindung zu setzen.

| Installation fortsetzen | ’ Installation abbrechen

Assistent fiir das Suchen neuer, Hardware

Fertigstellen des Assistenten

Die Software fur die folgende Hardware wurde ingtalliet;

=

Cyprezz Generic USE Device

Klicken Sie auf "Fertig stellen”, um den Yargang abeuschlisfen.
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5 USB Drivers Installation

Assistent fiir das Suchen neuer Hardware

Willkommen

Mit diezem Azziztenten konnen Sie Software fur die folgende
Hardwarekomponente installieren:

DeweSoft USE Device

; '_) Fallz die Hardwarekomponente mit einer CD
4 oder Diskette geliefert wurde, legen Sie diese
jetzt ein.

‘Wie mochten Sie vorgehen?

(O Software automatizch instaliersn (empfohlen)

() Sottware von einer Liste oder bestimmten Guelle
iinstallieren [fur fortgeschiittene Benutzer] i

Klicken Sie auf "wWeiter”, um denYorgang fortzuzetzen.

I W eiter > l [Abbrechen ]

Assistent fiir das Suchen neuer Hardware

W ahlen Sie die Such- und Installationsoptionen.

Yerwenden Sie die Kontrollkastchen, um die Standardsuche zu enweitern oder
einzuzchranken. Lokale Pfade und Wechselmedien sind in der Standardsuche mit
einbegriffen. Der zutreffendste Treiber wird installiert.

[ 'wechselimedien durchsuchen [Diskette, CD,...)
Folgende Quelle ebenfalls durchsuchen:

CATE30Ddiiver v

() Hicht suchen, sondern den zu instalierenden Treiber selbst wahlen

Verwenden Sie diese Optioh, um einen Geratetraiber aus einer Liste 2u wahlen, Eg wid
nicht garantiert, dass der von lhnen gewshlte Treiber der Hardware am besten entspricht.

’ £ Zuriick ” Wieiter » I ’Abbrechen]

Hardwareinstallation

L ] E Die Software, die fur diese Hardware installiert wird:
-
DEWESaft USE Device

hat den Windows-Logo-Test nicht bestanden, der die Kompatibilitat mit
Windaws ¥P Uiberpriift, [wWarum ist dieser Test wichtig?)

Das Fortsetzen der Installation dieser Software kann die korrekte
Funktion des Systems direkt oder in Zukunft beeintrachtigen.
Microzoft empfiehlt strengstens, die Installation jetzt abzubrechen
und sich mit dem Hardwarehersteller fur Software, die den
Windows-Logo-Test bestanden hat. in ¥erbindung zu setzen.

| Iristallation fortzetzen | [ Iristallation abbrechen
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6 B2B Connectors Pin Descriptions UM-TEO0630 (v 0.21) 3 July 2013

6.3 J4 Pin-out
Type FPGA pin Type FPGA pin Net
Length
(mm)
1 VCCIO0 POW - - 2 VCCIO0 POW - -
3 VCCIO0 POW - - 4 VCCIO0 POW - -
5 V3_10_01 slo G6 13.30 6 V3_10_06 slo c4 15.26
7 V3_l0_02 slo G4 11.05 8 V3_10_07 slo D3 17.04
9 V3_10_03 slo F5 10.46 10 V3_10_08 slo E6 14.97
11 V3_10_04 slo E5 10.08 12 V3_I0_09 slo D5 13.84
15 V3_l0_05 slo F7 10.16 16 VO_I0_11_P DIO B6 12.29
17 V0_IO_01 slo A4 5.16 18 VO_I0_11_N DIO A6 10.84
19 VO_IO_01_N DIO A5 5.14 20 VO_IO_12_N DIO A7 10.95
21 V0_IO_01_P DIO c5 6.84 22 VO_IO_12 P DIO c7 12.30
25 V0_I0_02 N DIO cé 7.27 26 VO_I0_13 N DIO A8 10.41
27 V0_IO_02_P DIO D6 8.16 28 V0_IO_13_P DIO B8 11.74
29 V0_IO_03_P DIO D7 7.93 30 VO_IO_14 N DIO A9 10.40
31 V0_IO_03_N DIO c8 7.21 32 VO_IO_14_P DIO c9 12.81
33 3.3V POW - - 34 3.3V POW - -
35 V0_IO_04_P DIO D9 9.34 36 V3_10_10 slo M7 21.84
37 V0_IO_04 N DIO D8 10.08 38 VO_CLK_04 N clo c12 12.96
39 | VO_CLK 03 P clo B12 6.00 40 VO_CLK_04_P clo D11 13.32
41 VO_CLK_03_N clo A12 05.01 42 VO_CLK_01_N clo A10 10.97
Il oo 2 oo B - 44 | VO_CLK 01_P cio B10 11.84
45 | VO_CLK 02 P clo C11 7.93 46 GND GND - -
47 | VO_CLK 02 N clo A1 10.76 48 V0_I0_15 N DIO A15 11.79
49 V0_IO_05_P DIO c13 7.20 50 V0_IO_15_P DIO c15 13.66
51 V0_IO_05 N DIO A13 6.11 52 V3_10_11 slo M8 26.06
53 2.5V POW - - 54 2.5V POW - -
55 V0_lO_06_P DIO D10 12.84 56 V0_IO_16_P DIO B16 12.98
57 V0_IO_06_N DIO c10 13.09 58 V0_IO_16_N DIO A16 10.96
59 V0_IO_07_P DIO F10 16.22 60 VO_IO_17_P DIO c17 16.33
61 V0_IO_07_N DIO E10 15.43 62 VO_I0_17 N DIO A17 13.51
65 V0_IO_08_N DIO A14 8.21 66 V0_IO_18_P DIO B18 15.19
67 V0_IO_08_P DIO B14 9.11 68 V0_IO_18 N DIO A18 13.77
69 V0_IO_09_N DIO c14 9.40 70 E18 -
71 V0_IO_09_P DIO D15 9.40 72 E14 -
73 1.2V POW - - 74 - -
75 VO_IO_10_N DIO c16 9.65 76 D14 -
77 V0_IO_10_P DIO D17 9.58 78 E16 -

Table 21: J4 connector pin-out
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6.4 J5 Pin-out
Type FPGA pin Net J5 pin Type FPGA pin Net
Length Length
(mm) (mm)
1 5Vb2b POW - - 2 5Vb2b POW - -
3 5Vb2b POW - - 4 5Vb2b POW - -
5 5V POW - - 6 /MR SYS - -
7 B2B_D_P UsSB - - 8 /RESET SYS - -
9 B2B_D_N UsB - - 10 RESET SYS - -
13 V3 _10_12 SIO T2 19.97 14 V3 _10_16 SIO U1 10.26
15 V3_10_13 SIO T1 18.91 16 V3_10_17 SIO u3 11.74
17 V2_10_01 SIO V15 18.18 18 V3 _10_18 SIO V1 9.72
19 V3_10_14 SIO AA2 16.26 20 V3_10_19 SIO V2 10.03
21 V3_l0_15 SIO AB2 15.23 22 V3_10_20 SIO Y1 9.21
25 V2_I0_01_N DIO AB6 10.68 26 V3_10_21 SIO Y2 8.73
27 V2_I0_01_P DIO AAB 12.54 28 V3 10_22 SIO AB3 6.68
29 V2_10_02_P DIO Y7 13.32 30 V3_10_23 SIO Y3 8.38
31 V2_10_02_N DIO AB7 11.56 32 V3 10_24 SIO AB4 6.65
33 V3_10_27 SIO us 8.41 34 V3_10_25 SIO AA4 7.51
35 3.3V POW - - 36 3.3V POW - -
37 V2_I0_03_N DIO AB8 12.43 38 V3_10_26 SIO Y4 8.41
39 V2_|0_03_P DIO AA8 13.01 40 V2_|10_10_P DIO Wé 9.20
41 V2_10_02 SIO AB12 12.62 42 V2_I0_10_N DIO Y6 8.31
45 V2_CLK_01_N ClO AB11 11.34 46 V2_I0_11_N DIO Y8 8.09
47 V2_CLK_01_P ClO Y11 12.64 48 V2_10_11_P DIO W9 9.10
49 V2_|0_04_P DIO W15 14.63 50 V2_10_12_P DIO Y9 8.40
51 V2_10_04_N DIO Y16 12.42 52 V2_10_12_N DIO AB9 6.60
53 2.5V POW - - 54 2.5V POW - -
55 V2_10_05_N DIO u14 17.21 56 V2_CLK_02_N ClO AB10 7.26
57 V2_10_05_P DIO T14 18.75 58 V2_CLK_02_P ClOo AA10 8.16
59 V2_10_06_P DIO AA14 12.39 60 V2_l0_13_P DIO W11 11.39
61 V2_10_06_N DIO AB14 11.34 62 V2_10_13_N DIO Y10 10.30
65 V2_10_07_N DIO AB15 11.87 66 V2_10_14_N DIO Y12 9.80
67 V2_10_07_P DIO Y15 13.55 68 V2_I0_14_P DIO W12 10.80
69 V2_10_08_P DIO AA16 12.61 70 V2_10_15_P DIO Y13 10.20
71 V2_10_08_N DIO AB16 11.72 72 V2_10_15_N DIO AB13 8.40
73 1.2v POW - - 74 1.2V POW - -
75 V2_I0_09_N DIO AB18 11.91 76 V2_10_16_N DIO Y14 9.72
77 V2_10_09_P DIO AA18 12.57 78 V2_I0_16_P DIO w14 10.72

Table 22: J5 connector pin-out
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API
B2B
DSP
EDK
0B

ISP
PB
SDK
TE
XPS

A CAUTION notice denotes a risk. It calls attention to an operating procedure, practice, or the like that, if not correctly
performed or adhered to, could result in a fault. (undesired condition that can lead to an error) Do not proceed beyond a
CAUTION notice until the indicated conditions are fully understood and met.

application programming interface
board-to-board

digital signal processing; digital signal processor
Embedded Development Kit

input / output blocks; 1/0 blocks

intellectual property

In-System Programmability

push button

Software Development Kit

Trenz Electronic

Xilinx Platform Studio

9 Legal Notices

9.1 Document Warranty

The material contained in this document is provided “as is” and is subject to
being changed at any time without notice. Trenz Electronic does not warrant the
accuracy and completeness of the materials in this document. Further, to the
maximum extent permitted by applicable law, Trenz Electronic disclaims all
warranties, either express or implied, with regard to this document and any
information contained herein, including but not limited to the implied warranties
of merchantability, fitness for a particular purpose or non infringement of
intellectual property. Trenz Electronic shall not be liable for errors or for
incidental or consequential damages in connection with the furnishing, use, or
performance of this document or of any information contained herein.

9.2 Limitation of Liability

In no event will Trenz Electronic, its suppliers, or other third parties mentioned in
this document be liable for any damages whatsoever (including, without
limitation, those resulting from lost profits, lost data or business interruption)
arising out of the use, inability to use, or the results of use of this document, any
documents linked to this document, or the materials or information contained at
any or all such documents. If your use of the materials or information from this
document results in the need for servicing, repair or correction of equipment or
data, you assume all costs thereof.

9.3 Copyright Notice

No part of this manual may be reproduced in any form or by any means
(including electronic storage and retrieval or translation into a foreign language)
without prior agreement and written consent from Trenz Electronic.
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9.4 Technology Licenses

The hardware / firmware / software described in this document are furnished
under a license and may be used /modified / copied only in accordance with the
terms of such license.
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Presence of hazardous substances in electrical and electronic equipment
results in potential effects on the environment and human health. The symbol
consisting of the crossed-out wheeled bin indicates separate collection for

waste electrical and electronic equipment.
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Appendix A. Indirect SPI Programming using iMPACT

To indirect program SPI Flash using Xilinx iIMPACT do following steps:

Connect JTAG cable to corresponding module connector (see 2.6 JTAG
connector).

Connect JTAG cable to host computer with installed Xilinx IMPACT software.

Power-on module by external power supply source or by USB cable.
Run Xilinx iMPACT.

Select Boundary Scan mode.
After initialization iIMPACT window should look like

s 05 ey S i
@m Edit  Miew Operations Output Debug Window Help
Du--'H ﬂ'b‘-i‘lljx..‘gg]‘%= '_‘:'_ .f"'h?

iMPACT Flows +08F x
oa Boundary Scan EFL/EET
=] SystemACE L--f
=] Create PROM File (PROM File Format...
=] WebTalk Data ol
xcis1200e
bypass
ToO
MPACT Processes +0 88 x
Available Operations are:
md Get Device ID
m) Get Device Signature/Usercode
=P Read Device Status

@ Boundary Scan |

Console +0 &8 X

J/ ®=%#% BALTCH CMD : setPreference -pref SpiByteSwap:AUTC CORRECTION -
Sf ®=#% BLTCH CMD : =setPreference -pref LutoInfer:TRUE
Sf ##%% BLTCH CMD : setPreference -pref S5viPlayDisplayComments:FALSE

I

‘|
Console ‘o Errors |_ﬂ Warnings

Configuration |Platform Cable USB |6 MHz ush-hs

Right click on FPGA image and select “Add SPI/BPI Flash...” from menu.
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@ [SE iMPACT (0.61xd) - [Boundary Scan J

| File Edit View Gperatmns Output  Debug  Window Help
IMPACT Flows + 08 x|
::] Boundary Scan TEFLIBET
[2) systemACE
2] Create PROM File (PROM File Format...
- [2) WebTalk Data o — Get Device ID

Get Device Signature/Usercode

xcH -
by Add 5PIYBPI Flash...

ToO0— Assign Mew Configuration File..,
IMPACT Processes #0088 X Set Pregramming Properties...
Available Operations are: Set Erase Properties...
=P Get Device ID
md Get Device Signature/Usercode Launch File Assignrment Wizard

m Read Device Status

@ Boundary Scan
Console +0 8 x
S/ ##% BATCH CMD : setPreference -pref SpiByteSwap:AUTO CORRECTTION -
Jf{ #=*% BALTCH CHMD : setPreference -pref AutoInfer:TRUE
f/ ®#%#% BATCH CHMD : setPreference -pref S5vfPlayvDisplavComments:FALSE =

LI r

]
Console ré Errors |__f_\ Warnings

Configuration | Platform Cable USE |6MH2 rlusb-hs

Select mcs file to program.
Select SPI Flash type corresponding to your module type and revision.

e e

Select the PROM attached to FPGA:

eremom ] I —|

Lo ] [ ]

Right click on Flash image and select “Program” from menu.
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5 st 0o ey I -]

.@ File Edit View Operations Output Debug  Window Help IZ"EIE
DAH #$ DX m%: 2832 =T AN
IMPACT Flows a=N-53

Right click device to select operations

- 59 Beundary Scan

o |2] Create PROM File (PROM File Format... Veri
: eri
G- [Z] WebTalk Data O — JEx v
Erase
Blank Check
xcist
Readback...
by ,
TDO Get Device Checksum
iMPACT Processes 08 X ] ] ] ]
- - Assign Mew Configuration File...
Available Operations are: -
= Program e
=P Verify Set Programming Properties...
=P Erase Set Erase Properties...

md Blank Check
m) Readback

=) Get Device Checksum A8 '@ Boundary  Launch File Assignment Wizard

i, Dmmel Mhmssimm Cmdare

Edit Attached Flash Properties..,

Conzole +0F X

iy INFO:iMPACT — A CFI file is not detected. To ensure correct and safe conf »
Flease make sure a CFI file is present in the same directory as the PROM
or, regenerate the PRCOM file with the latest software.

=
i
« m .
Console Fé Errors |_|‘}. Wam'rr1gs|

|Com‘iguration |P|atform Cable USB |6MH2 |_|usb-h5

Leave default programming properties and press “OK”.

@ Device Programming Properties - Device 1 Progra

Category

= Boundary-5can
- Device1 [ FPGA xc3s1200e ) Property Name
Devicel [ Attached FLASH, M25P3 Verify

Design-Specific Erase Before Programming

After programming Flash... automatically load FPGA with

Wait for operation to complete.
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